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Inleiding 

 

Op de nu volgende pagina's worden alle onderdelen van de digitale fotobewerking behandeld te beginnen 
met de kleurinstellingen van hard- en software in de onderdelen Beeldscherm, Software, Printer en Scan-
nen. Dan komen alle handelingen in Photoshop aan de orde in het hoofdstuk Beeldbewerking. De toegepas-
te techniek is bijna nooit in een samenhangende vorm te vinden in de vele handboeken over Photoshop. 

 

Aan de hand van een doorsnee foto wordt stapsgewijs het gehele proces doorlopen, waarbij de desbetref-
fende schermbeelden voor verduidelijking zorgen. Aan de theoretische achtergronden wordt weinig aan-
dacht besteed. Er is een lijst met interessante websites opgenomen. Hier vindt de liefhebber uitvoerige theo-
retische beschouwingen.  

 

Om te komen tot optimale resultaten is het belangrijk de bewerkingsvolgorde aan te houden zoals deze is 
beschreven. Een aantal bewerkingen tasten de digitale informatie van de foto aan en als zo'n bewerking in 
een te vroeg stadium wordt uitgevoerd kan dit nadelig uitpakken voor de kwaliteit van het eindresultaat. 

 

Alle pagina's van deze web site kunnen vanuit Internet Explorer of Netscape worden afgedrukt. Kies daar-
voor in Internet Explorer: Bestand>Afdrukvoorbeeld> Afdrukken of - in de Engelse versie: File>Print pre-
view>Print. Tevens is van alle teksten samen een "pdf-versie" opgenomen, die kan worden gedownload en 
met Adobe Acrobat Reader kan worden geopend. Dit vergemakkelijkt het nalezen.  
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Kleur instellen 

 

Elk computersysteem bestaat uit componenten, die door verschillende fabrikanten zijn samengesteld. Iedere 
fabrikant wil dat zijn product - onafhankelijk van de andere componenten - maximaal presteert. Daartoe le-
vert hij een pakket software - drivers ofwel stuurprogramma's - die dat maximale functioneren bevorderen . 
Helaas verzuimt hij meestal de gebruiker in detail te vertellen op welke manier zijn product in het geheel 
functioneert. Meestal is dit ook niet zo belangrijk; als de printer maart print, het beeldscherm beeld geeft en-
zovoort. 

 

Zodra we echter met kleuren te maken hebben is het wel belangrijk om te weten hoe de kleurinformatie in de 
verschillende componenten aan elkaar wordt doorgegeven. Hiertoe wordt gebruik gemaakt van kleurprofie-
len, die volgens internationaal geaccepteerde conventies zijn vastgesteld. Toch is het niet voldoende om in 
elke onderdeel hetzelfde kleurprofiel te installeren omdat sommige instellingen in een voorgaand of volgend 
traject roet in het eten kunnen gooien. Gelukkig zijn er mensen, die uit oogpunt van hun vak of van hun hob-
by zo ver gaan dat ze met de verschillende fabrikanten contact opnemen en uitpluizen hoe de software in el-
kaar zit. Op internet is deze informatie te vinden en de praktische uitwerking is in deze handleiding samen-
gebracht.  

 

Achtereenvolgens komen de instellingen aan de orde van 

 

* beeldscherm,  

 

* beeldbewerkings software,  

 

* printer  

 

Door deze instellingen te volgen wordt voor de amateur een aanvaardbare kleuroverdracht tussen de com-
ponenten bereikt. 

De professionele fotograaf zal veel gedetailleerder te werk gaan en zijn eigen kleurprofielen samenstellen. 
Hij kan dan gebruik maken van tamelijk kostbare densitometers, die onder andere worden geleverd door 
GretagMacbeth. Op hun website is het een en ander na te lezen. 
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Beeldscherm 

In de volgende hoofdstukken komen we het be-
grip kleurprofiel tegen. Zowel Windows als 
beeldbewerkingsoftware beschikt over een 
groot aantal kleurprofielen. De verschillende 
versies van Windows slaan deze profielen op 
verschillende plaatsen op. Zoek eerst uit waar 
zich op jouw computer de kleurprofielen bevin-
den. Ga naar Start>Zoeken>Bestanden of 
mappen. Zoek naar *.icc en/of *.icm. Noteer de 
map. 

 

Allereerst wordt het beeldscherm ingesteld. Dit 
doen we met Adobe Gamma. Open het Confi-
guratiescherm 
(Start>Instellingen>Configuratiescherm) en 
dubbelklik op Adobe Gamma.  

Selecteer in het scherm Stap-voor-stap (Wi-
zard), klik op Volgende. 

Let er op dat er bij Beschrijving staat: "Adobe 
RGB (1998)". Zo niet, klik dan op Load, en se-
lecteer dit kleurprofiel in de Map die je eerder 
hebt gevonden. Klik op Volgende en volg de 
aanwijzingen in de verschillende schermen op. 
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Het volgende scherm vraagt om de instelling 
van contrast en helderheid. Dit moet aan de 
monitor zelf gebeuren en verschilt per merk en 
type. Stel eerst het contrast zo hoog mogelijk in 
en pas vervolgens de helderheid zodanig aan 
dat het binnenste vierkantje bijna - maar niet 
helemaal - zwart is. De buitenrand moet helder 
wit blijven. Klik op Volgende. 

De instelling van de schermfosfors wordt veelal 
door Adobe Gamma zelf gevonden. Hieraan 
hoeft in deze beginnersfase niets te worden 
veranderd.  

Bij beeldschermen van A-merken kan op Inter-
net de gedetailleerde waarde van de beeld-
schermfosfors worden gevonden; het verdient 
dan aanbeveling om deze waarden in te vullen. 
Kies dan in het keuzemenu voor Eigen en vul 
de waarden in. Klik OK 

Klik op Volgende. 

Selecteer "Alleen Gamma bekijken" en pas met 
de schuifregelaar de kleur van het binnenste 
vierkantje aan de gearceerde rand aan. Dit kan 
het beste door met "geloken" ogen van enige 
afstand (armlengte) naar het beeldscherm te 
kijken. 
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Vervolgens "Alleen enkel Gamma bekijken" de-
selecteren, waardoor de drie kleurkanalen rood, 
groen en blauw zichtbaar worden. Hier op de 
zelfde manier de kleuren van de binnenste vier-
kantjes aanpassen. Kies tenslotte voor "Win-
dows- standaard Gamma". Klik op Volgende. 

De witbalans wordt vastgesteld door uit de 
keuzelijst te kiezen. Indien je niet zeker bent 
kun je ook een meting uitvoeren. Klik op Meten 
en kies uit één van de drie verschijnende 
vierkanten. Doe dit net zo vaak totdat het 
middelste vierkant naar jouw mening een 
neutraal grijze kleur weergeeft. Klik op 
Volgende 

De meest bevredigende oplossing voor de 
aangepaste witbalans biedt de keuze "Gelijk 
aan hardware". Klik op Volgende 
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Door afwisselend "Voor" en "Na" te kiezen kun 
je zien wat het eindresultaat is van je instellin-
gen. Als je nu op Voltooien klikt wordt je ge-
vraagd de instellingen op te slaan. Kies hier-
voor de bestandsnaam: Adobe RGB 
(1998)_Nieuw.icc. Je laat dan het oorspronke-
lijke profiel onaangeroerd, zodat je in de toe-
komst bij een nieuwe installatie opnieuw hier-
van uit kunt gaan. 
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Adobe Photoshop 7.0 

De tweede stap regelt het instellen van de kleurprofielen voor de software. Adobe Photoshop wordt 
algemeen beschouwd als de beste software op dit gebied. Daarom beschrijf ik de instellingen aan de hand 
van dit product. 

Open Kleurinstellingen (Bewerken>Kleurinstellingen) 

We negeren de standaard instellingen van Photoshop. Klik om te beginnen op Geavanceerde modus. 
Hiermee komen nog enkele instellingen beschikbaar, die eerst verborgen waren. 

 
 

In de sectie Werkruimten kies je voor: 

* RGB - Adobe RGB (1998). 

(RGB staat voor Rood, Groen en Blauw, de drie primaire kleuren waarmee alle kleuren op het beeldscherm 
worden opgebouwd.) 

* CMYK - US Web Coated (SWOP) v2. 

(CMYK staat voor Cyaan, Magenta, Yellow, de complementaire kleuren waarmee in een drukproces alle 
kleuren worden opgebouwd; de K staat voor zwart. In theorie bestaat zwart uit een combinatie van Cyaan, 
Magenta en Yellow. 

In de praktijk is dit resultaat minder diepzwart dan wanneer puur zwarte inkt wordt gebruikt.) 

* Grijs - Gray Gamma 2.2 
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* Steunkleur - Dot Gain 20%  

In de sectie Beleid voor Kleurbeheer kies je voor: 

* RGB - Omzetten in tijdelijk RGB 

* CMYK - Ingesloten profielen behouden 

* Grijs - Ingesloten profielen behouden 

Klik de drie selectievakjes "Vragen bij..." aan 

In de sectie Opties voor omzetten kies je voor: 

* Engine - Adobe (ACE) 

* Intent - Perceptual 

Klik de twee selectievakjes Compensatie en Dithering aan  

 

In de sectie Geavanceerde instellingen wordt niets aangeklikt. 

 

Tenslotte Opslaan in de rechter kolom aanklikken en de Kleurinstellingen opslaan als 

"Je naam _Default.csf" (zonder aanhalingstekens). Door het gebruik van je eigen naam is de instelling 
steeds terug te vinden en kom je niet in verwarring met andere voorinstellingen. 
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Afdrukken 

De derde stap in het proces van kleurinstellingen betreft het afdrukken. Hier komen twee afzonderlijke ge-
bieden aan de orde. Ten eerste moeten we vaststellen hoe Photoshop omgaat met het transport van de 
kleurinstellingen naar de printer en vervolgens besteden we aandacht aan de manier waarop de printer met 
de verkregen informatie omgaat. 

Open het scherm Afdrukken met Afdrukvoorbeeld (Bestand>Afdrukken met afdrukvoorbeeld). 

 
De onderdelen Positie en Geschaalde Afdrukgrootte gebruik je bij iedere afdruk afzonderlijk omdat je hier de 
afmetingen van de foto kunt afstemmen op het te gebruiken papier. Nu gaat het ons om de juiste instellingen 
voor de kleur en die zijn voor elke afdruk gelijk. 

Selecteer "Meer opties tonen" 

Kies vervolgens voor "Kleurbeheer". 

Selecteer bij Bronruimte "Document". Als de instelling in het hoofdstuk Photoshop voor Werkruimte "Adobe 
RGB (1998)" aangeeft dan komt dit kleurprofiel hier terug. 

Selecteer bij Afdrukgebied>Profiel "Als bron". 

Nu ben je er zeker van dat de kleuren van Photoshop worden doorgegeven aan de printer. 

 

De printer 

De printer moet nu nog goed omgaan met de uit Photoshop verkregen informatie. Elke printerfabrikant bouwt 
zijn eigen kleurinstellingen in de printer in omdat de gebruiker de keuze heeft uit veel verschillende pakket-
ten bewerkingssoftware. 

Het is onbegonnen werk om de instellingen voor alle verschillende printers aan te geven. Daarmee zou op 
zich een web site kunnen worden gevuld en toch zouden we steeds achter de feiten aanlopen omdat voort-
durend verbeterde printers verschijnen. 

Uit alle tests - zowel in binnenlandse als buitenlandse tijdschriften - komen de Epson Stylus Photo printers 
(in diverse uitvoeringen) als beste naar voren als het gaat om kleurweergave. Daarom volgt hieronder het 
voorbeeld voor deze printers. 

Open opnieuw het scherm Afdrukken met Afdrukvoorbeeld (Bestand>Afdrukken met afdrukvoorbeeld) en klik 
Pagina-instelling en vervolgens Printer en Eigenschappen. 
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Selecteer bij: 

Afdrukmateriaal - Premium Glossy Photo Paper 

Inkt - Kleur  

Modus - Aangepast 

Afdrukvoorbeeld - Aanklikken 

Klik nu: Geavanceerd 
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Afdrukmateriaal en Kleur zijn reeds ingesteld. Selecteer bij Afdrukkwaliteit "Foto 1440 dpi" 

Menige printer is tot een hogere resolutie in staat. Het is echter mijn ervaring, dat - in combinatie met IL-
FORD Smooth Gloss Paper - een prima dekking wordt verkregen. De inkt droogt goed en de afdruk lijkt op 
een foto. Verder is de prijs van dit kwaliteitspapier redelijk. 

Selecteer bij Kleurbeheer "ICM" en zorg er voor dat Hoge snelheid, Horizontaal spiegelen en Bladrand niet 
zijn aangeklikt. 

Instellingen opslaan onder: 

"Je naam_foto_kleur" (zonder aanhalingstekens) 
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Scannen 

Er zijn verschillende manieren om een foto om te zetten in een digitaal 
bestand. De fotowinkel kan de negatieven op een CD zetten. De foto-
afdruk kan met een flatbedscanner worden gescand. Het negatief of de 
dia kan met een negatiefscanner worden gescand. Alle methodes hebben 
hun specifieke voor- en nadelen. 

De beste manier is nog steeds om een zo goed mogelijke negatief/dia-
scanner aan te schaffen. Bedenk wel dat deze apparaten vrij duur zijn. 
Een aanvaardbare kwaliteit kost al gauw tegen de € 400,=. Met aanvaard-
baar bedoelen we dat de kritische amateur fotograaf met de geboden re-
solutie van rond de 3000 pixels per inch goed uit de voeten kan. Professi-
onele apparaten gaan dit getal ver te boven en de prijs stijgt evenredig. 
De amateur hoeft zich daarop echter niet blind te staren. 

De onderkant - wat prijs en kwaliteit betreft - zit bij de flatbedscanner. De-
ze zijn tegenwoordig voor ongeveer € 150,= te koop. De resolutie is echter 
in vergelijking met de negatiefscanners beperkt: ongeveer 1200 pixels per 
inch is zeer gangbaar. Nadeel van deze scanners is evenwel dat er een 
foto-afdruk wordt gebruikt.  

De kwaliteit van een digitaal bestand is mede afhankelijk van het aantal 
bewerkingen dat een negatief of dia heeft moeten ondergaan tot het mo-
ment van scannen. Een fotoafdruk is een stap verder dan een negatief. 
De fotograaf heeft daarbij geen invloed op de kleurinstellingen die door de 
fotowinkel - of afdrukcentrale - worden gebruikt.  

Het is algemeen bekend dat de geautomatiseerde afdrukmachines alle 
negatieven naar een neutrale kleurtint corrigeren, waardoor het merendeel 
van de klanten redelijk tot goed tevreden is. De kritische fotograaf zal 
hierdoor echter niet aan teleurstellingen ontkomen. 

Een praktische tussenoplossing is om de negatieven door de fotocentrale 
op een CD te laten zetten. Het ontwikkelproces wordt nauwelijks gecorri-
geerd en de beelden worden dan als "schone" digitale bestanden aange-
leverd. 

Scanner software 

De software die doorgaans bij scanners wordt geleverd munt in een aantal 
gevallen niet uit door kwaliteit. De fabrikant baseert zich op gebruiksvrien-
delijkheid en laat de software enkele correcties uitvoeren hetgeen wij juist 
niet willen. Nu is het wel zo, dat gescande transparanten doorgaans kleur-
zweem vertonen. Beter is het om dit in de scanfase te laten zitten en de 
foto er van te ontdoen in de fase van bewerking. Goede bewerkingssoft-
ware - vooral Photoshop - is zoveel beter dan de scansoftware, dat de 
laatste eerder kwaad dan goed doet. 

Er zijn twee softwarepakketten, die een groot aantal verschillende scan-
ners bedienen. In de eerste plaats noemen we Silverfast van Lasersoft 
Imaging. Dit pakket is vooral afgestemd op de bezitters van digitale ca-
mera's die niet over Photoshop beschikken.. Daarnaast ondersteunt het 
een aantal scanners. Het programma is van hoogwaardige kwaliteit maar 
daarbij tamelijk duur. Bespreking blijft hier verder achterwege; de web site 
van de fabrikant is opgenomen in "Interessante web sites" zodat belang-
stellenden er kennis van kunnen nemen. Een uitgebreide bespreking is te 
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vinden in "Computer-Darkroom". 

Hier wordt verder het programma VueScan besproken. Het is aanmerke-
lijk goedkoper en is zodanig ingericht dat van zowel foto's als van negatie-
ven of dia's prima scans kunnen worden gemaakt. Daarnaast is het ook 
goed bruikbaar om digitale bestanden van een CD binnen te halen. 

Van belang zijn de instellingen onder Device, Color en Files. Hier staat 
een pagina waarop de voorbeelden van de instellingen zijn opgenomen. 
(Alleen van belang indien men over VueScan beschikt) 

 



Digitale Doka © Henk Backer 2003-2004 Alle rechten voorbehouden -  Pagina 15 

Voorwoord 

De ontwikkelingen in digitale fotobewerking bieden de mogelijkheid om zelf je foto·s meer op je eigen smaak 
en creativiteit aan te passen zonder daarbij afhankelijk te zijn van de afdrukcentrale. Als je nooit bent toege-
komen aan een donkere kamer om je eigen kleurenfoto·s af te drukken, dan heb je nu de kans om meer ei-
gen ideeën in je foto aan te brengen en daarmee de foto meer je eigen product te maken. 

De opmars van de digitale camera brengt de mogelijkheid dichterbij om de foto rechtstreeks vanuit de came-
ra in de computer over te brengen. De noodzaak van scannen vervalt hiermee. Nu ook uitstekende en be-
taalbare fotoprinters op de markt zijn wordt het helemaal aantrekkelijk om je foto van het begin tot het eind af 
te werken. Voor de kosten hoef je het ook niet te laten; zelf doen is ongeveer even duur als de één-uur ser-
vice bij de meeste fotowinkels. 

De hoofdstukken in deze handleiding zijn de verschillende stappen in de bewerking en staan in de volgorde 
die tot de beste resultaten leidt. De volgorde is belangrijk omdat sommige bewerkingen kunnen leiden tot 
enig verlies van digitale informatie. Zo·n bewerking vindt dan plaats als dat verlies niet meer van invloed is 
op de kwaliteit van het eindresultaat. 

De beschrijving is gebaseerd op de Nederlandse versie van Photoshop 7.0. De handleiding is een nagenoeg 
letterlijke vertaling uit het Engels van ·An Image Processing Workflow· van de Amerikaan Fred Scholz, die dit 
heeft gepubliceerd op de website van de fotograaf Michael Reichman (http://luminous-landscape.com/). Mi-
chael heeft mij voor deze vertaling toestemming gegeven.  

Op enkele plaatsen is afgeweken van de oorspronkelijke tekst omdat de aanwijzingen daarin niet algemeen 
toepasbaar bleken. Michael Reichman schrijft in zijn introductie onder meer: ·Deze handleiding is geen wet 
van Meden en Perzen. Sommige benaderingen lijken misschien overdreven, terwijl ervaren fotografen in-
middels zelf een methode hebben ontwikkeld waarbij zij zich gelukkig voelen. Gebruik uit deze handleiding 
wat je zinvol lijkt. Volg hem niet slaafs. De handleiding is echter een prima wegwijzer bij het ontwikkelen van 
je eigen werkwijze. 
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Invoeren 

Digitale camera: Indien mogelijk verdient het aanbeveling de foto op te slaan in RAW-formaat middels de 
software die bij de camera is meegeleverd of met behulp van een programma van derden, zoals Breeze-
Browser (voor Canon) of Bibble (voor Nikon). 

Vervolgens kan het bestand worden omgezet naar 48-bit TIFF-formaat. Vermijd hier -indien mogelijk - JPEG-
formaat; bij het comprimeren gaat waardevolle bestandsinformatie verloren. JPEG is alleen geschikt voor 
presentatie op internet of als bijlage bij e-mail. 

Scanner: Scan de dia of het negatief in op een zo hoog mogelijke resolutie. De meeste transparantscanners 
voor de amateur gaan tot ± 2800 - 3000 ppi (pixels per inch). Schakel 48-bit in. Breng tijdens het scannen 
geen aanpassingen in het bestand aan tenzij je beschikt over scanner software die van betere kwaliteit is 
dan wat veelal bij scanners wordt geleverd. Voorbeelden van goede scanner software zijn Silverfast 6.0 (ta-
melijk duur en niet voor alle scanners beschikbaar) en Vuescan. 

Sla het bestand in TIFF-formaat op in je map Beeldinvoer 

Open het bestand in Photoshop en zet het om naar je kleurenwerkruimte (bij voorkeur Adobe RGB 1998). 

Klik op F om het beeld los van de vensterrand in het midden van de werkplek te plaatsen. 

Zet het beeld indien nodig recht. Als de horizon of de verticale lijn van een gebouw niet helemaal recht staat, 
pas dit dan als volgt aan: Kies Meetlat onder de Pipet (of toets Shift+I net zo vaak totdat Meetlat verschijnt). 
Teken nu een lijn langs de horizon of langs de verticale zijde van een bouwwerk. Het beeld kan nu worden 
recht gezet door te klikken op Afbeelding>Canvas roteren> Instelbaar>OK 

 



Digitale Doka © Henk Backer 2003-2004 Alle rechten voorbehouden -  Pagina 17 

Bijsnijden en reinigen 

Verwijder eerst de zwarte en blanco delen, die de kleurendiagram (histogram) kunnen verstoren. Wijzig in dit 
stadium niet de afmetingen. 

Open Uitsnijden (C) en klik op Voorste Afbeelding (in de werkbalk); teken losjes een omlijning rond het 
beeld. Sleep nu met de muis (linker knop) de hoekankers van de omlijning naar binnen zodat de zwarte of 
blanco delen er buiten vallen. Verschuif de omlijning zonodig (muis binnen het vierkant en de linker knop in-
drukken) zodat het afval zo beperkt mogelijk is. Toets Enter (of klik het vinkje in de werkbalk · rechts boven) 

Maak een duplicaat van het bestand (Afbeelding>Dupliceren) en sla het duplicaat op als backup. 

Verwijder nu vlekjes en andere ongerechtigheden. 

Toets Ctrl+Alt+0 om het beeld te vergroten naar 100% en open het Historie palet (Venster>Toon Historie). 

Maak het beeld nu enigszins donkerder (Afbeelding>Aanpassen>Helderheid/Contrast) en plaats de schuif-
regelaar Helderheid op ·3. 

Open Filter>Ruis>Stof en krassen 

Plaats beide schuifregelaars uiterst links 

Plaats de vierkante cursor op een stofvlekje; beweeg de schuifregelaar Straal zover naar rechts tot het vlekje 
verdwijnt.; beweeg nu de schuifregelaar Drempel zo ver mogelijk naar rechts zonder dat het vlekje zichtbaar 
wordt; klik OK. 

Maak een Opname (klik op het kleine driehoekje rechts boven in het Historie palet); klik in het vierkantje links 
in het Opname balkje in het Historie palet; hierdoor wordt het Historiepenseel geactiveerd. 

Ga nu in het Historie palet één stap terug en activeer deze. 

Open het Historiepenseel (Y); neem in de werkbalk een zacht penseel van ongeveer 17 en stel de Modus in 
de werkbalk op Lichter en de Dekking op 100%; toets Tab om alle paletten tijdelijk te verwijderen (ze komen 
weer tevoorschijn door opnieuw op Tab te toetsen). 

Stip nu met het ingestelde Historiepenseel alle vlekjes aan. Beweeg over het beeld door de Spatiebalk in te 
drukken (de cursor verandert in een handje) en met de muis een andere plek op te zoeken. Bewerk zo de 
gehele foto totdat alle ongerechtigheden zijn verdwenen. Dit kan een tijdrovende klus zijn maar is zeker de 
moeite waard als er later van de foto een vergroting wordt gemaakt. Eventuele ongerechtigheden komen 
dan overduidelijk naar voren. 

Krassen en haartjes kunnen worden verwijderd door met het Historiepenseel op een eind van de kras te 
klikken en vervolgens - terwijl Shift wordt ingedrukt - op het andere eind te klikken. 

Als de foto schoon is open dan weer Afbeelding>Aanpassingen>Helderheid/Contrast en zet de schuifrege-
laar voor Helderheid op +3 om de oorspronkelijke kleur terug te krijgen. 

 

Sla de foto op (Ctrl+S). 

 
Voor de bewerking 

 
Na de bewerking 
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Kleurtoon en witbalans 

Open het Info palet (Venster>Info); klik het kleurenpipet; stel de monstergrootte (in de werkbalk) op 3 x 3. 

We gaan nu referentiepunten plaatsen binnen de helderheiddrempels. Er zullen vier aandachtpunten ge-
plaatst worden met behulp van de kleurenpipet (Shift+I). We kunnen dit op drie verschillende manieren doen; 
we zullen ze achtereenvolgens beschrijven en iedere manier afsluiten met een Opname (Historie pa-
let>driehoekje>Nieuwe opname). Als de drie manieren zijn beschreven kun je de resultaten vergelijken door 
de drie opnames te bekijken en voor jezelf de gemakkelijkste manier onthouden. 

Eerste manier 

Klik op het kleine pipet in de linker bovenhoek van het Info palet. en kies Totale Inkt. 

Beweeg het kleurenpipet nu over de zwarte delen van de foto en bepaal het hoogste percentage in de linker 
bovenhoek van het Info palet; klik op die plek om referentiepunt #1 te bepalen 

Beweeg het kleurenpipet nu over de witte delen (waarin nog enig detail is te herkennen) en bepaal het laag-
ste percentage; klik op die plek om referentiepunt #2 te bepalen. 

Maak een opnamen (Historiepalet>driehoekje> Nieuwe opname) en noem de opname ·Eerste manier·. 

Tweede manier 

Open Niveaus (Afbeelding>Aanpassingen>Niveaus) 

Houd Voorbeeld aangeklikt, houd de Alt-toets ingedrukt (om de drempelmodus te tonen) en beweeg de 
(rechter) schuifregelaar van de Invoer voor de hoge kleuren naar links totdat de eerste duidelijke details ver-
schijnen. Beweeg de schuifregelaar terug (onthoud intussen de gevonden plek) en klik deze met het kleu-
renpipet voor referentiepunt #1. 

Doe nu hetzelfde voor zwart. Houd de Alt-toeots ingedrukt en beweeg de (linker) schuifregelaar van de In-
voer voor de schaduw kleuren naar rechts totdat de eerste duidelijke details verschijnen. Beweeg de schuif-
regelaar terug (onthoud intussen de gevonden plek) en klik deze met het kleurenpipet voor referentiepunt 
#2. 

Maak een opnamen (Historiepalet>driehoekje> Nieuwe opname) en noem de opname ·Tweede manier·. 

Derde manier 

De derde manier is de meest nauwkeurige en vooral van belang in foto·s met weinig contrast, waardoor de 
lichtste en donkerste plekken op het oog moeilijk te bepalen zijn. Deze manier is echter alleen toepasbaar op 
bestanden in 8-bit modus. 

Wijzig modus (Afbeelding>Modus>8-bits/kanaal). Kies Kleurenpipet (Shift-I) 

Open het Lagen palet (Venster>Lagen) 

Klik op het zwart-witte rondje onderaan het Lagenpalet en klik Drempel. Beweeg de schuifregelaar in het 
nieuwe venster naar rechts tot het einde van de histogram. Het hele beeld is nu zwart. Beweeg de schuifre-
gelaar langzaam terug totdat het eerste witte plekje verschijnt. Klik nu OK en klik met de Kleurenpipet op het 
witte plekje voor referentiepunt #1 . 

Dubbelklik nu op het venster de laag Drempel 1 van het Lagenpalet; het Drempel venster verschijnt weer en 
beweeg de schuifregelaar naar het linker eind van de histogram. Het hele beeld is nu wit. Beweeg de schuif-
regelaar langzaam terug totdat het eerste zwarte plekje verschijnt. Klik nu OK en klik met de Kleurenpipet op 
het witte plekje voor referentiepunt #2. 

Verwijder de laag Drempel 1 (Klik en sleep de laag naar de Afvalemmer (rechts onderaan in het Lagenpalet). 

Klik nu met het Kleurenpipet op een gebied dat neutraal grijs moet zijn voor referentiepunt #3 en klik op een 
gebied met de meest overheersende kleur voor referentiepunt #4. 

Sla het bestand op als ·Referentiepunten· 

Bepaal nu de beoogde printer voorkeur voor het witte en zwarte punt. Dit kan van printer tot printer verschil-
len maar voor de meeste Epson Photo printers gelden de volgende waarden indien ·Premium Glossy Photo 
Paper· wordt gebruikt. 

Open Niveaus (Afbeelding>Aanpassingen>Niveaus) 

Dubbelklik op de ·witpunt pipet· (de rechter) en verander de B (in de HSB waarden) van 100 in 95%; klik OK. 
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Dubbelklik op de ·zwartpunt pipet· (de linker) en verander de B (in de HSB waarden) van 0 in 5%; klik OK. 

De volgende stap in het proces van kleurcorrectie is het aanpassen van de Niveaus aan de gevonden refe-
rentiepunten. Hierdoor worden de witte en zwarte punten uiteindelijk vastgesteld. 

Open Niveaus (Afbeelding>Aanpassingen>Niveaus) en zoek nu naar ·zuiver wit·: open het Blauwe kanaal 
en beweeg de rechter schuifregelaar naar het eind van de histogram. Als de invoerwaarde minder is dan 244 
dan is er wellicht geen zuiver wit en kan deze stap worden overgeslagen. Is de invoerwaarde 244 of meer 
dan is er wel zuiver wit. Gebruik de witpunt pipet en klik in referentiepunt #1. 

Het is denkbaar, dat er behoefte is om zuiver wit te creëren (bijvoorbeeld om het contrast te verhogen). In 
dat geval kan ook met de witpunt pipet op referentiepunt #1 worden geklikt. 

Gebruik Voorbeeld afwisselend aan- of niet aangeklikt om het resultaat te beoordelen. Inzoemen met 
Ctrl+plus geeft de indruk van een detail. 

Het vaststellen van het ·zuiver zwart· verloopt langs de zelfde lijnen. Alleen wordt nu de linker schuifregelaar 
in het Blauwe kanaal naar het begin van de histogram bewogen. Gebruik de zwartpunt pipet en klik in refe-
rentiepunt #2. Als de invoerwaarde meer is dan 8 is er waarschijnlijk geen zuiver zwart en kan deze stap 
worden overgeslagen. 

Als ter wille van het contrast toch zuiver zwart gecreëerd wordt kan met de zwartpunt pipet op referentiepunt 
#2 worden geklikt. Ook hier is het van belang om het effect te beoordelen door afwisselend Voorbeeld aan of 
uit te zetten. 

Het is niet aan te raden om neutraal grijs op deze manier vast te stellen met de middelste invoerschuifrege-
laar. In een volgend hoofdstuk wordt het bepalen van neutraal grijs met meer detail behandeld. 

 
Foto met vier referentiepunten 

 
Wit- en zwartpunt gecorrigeerd 
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Dynamisch kleurbereik 

Het dynamische kleurbereik wordt nu · zonodig - gecorrigeerd door in het RGB kanaal de linker en rechter 
schuifregelaars aan het begin en eind van de histogram te plaatsen. Kom niet aan de middelste schuifrege-
laar. 

Open Niveaus (Afbeelding>Aanpassingen>Niveaus) 

Blijf in RGB en verplaats de schuifregelaars (linker en rechter) naar begin en eind van de histogram. 

Klik OK. 
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Kleurbalans 

Kleurzweem kan ontstaan als het omgevingslicht een andere kleurtemperatuur heeft dan de film. Ook het 
scannen leidt in de meeste gevallen enigermate tot kleurzweem. 

Open de foto en kijk naar referentiepunten #1 en #2. De RGB-waarden moeten gelijk zijn, te weten 255, 255, 255
voor referentiepunt #1 en 0, 0, 0 voor referentiepunt #2. Dan is er geen kleurzweem in de hoge lichten 
en ook niet in de schaduwen. Zijn de waarden niet gelijk, dan gaan we als volgt te werk. 

Open Niveaus (Afbeelding>Aanpassingen>Niveaus) 

Kies het kleurkanaal met de laagste waarde voor referentiepunt #1 (zie Info palet) en beweeg de rechter 
schuifregelaar naar links tot de waarde gelijk is aan de hoogste waarde (meestal 225). Doe dit eventueel ook 
voor het kanaal waarvan de waarde evenmin gelijk is aan de hoogste waarde. 

Kies nu het kleurkanaal met de hoogste waarde voor referentiepunt #2 (zie Info palet) en beweeg de schuif-
regelaar naar rechts tot de waarde gelijk is aan de laagste waarde (meestal 0). Doe dit eventueel ook voor 
het kanaal waarvan de waarde evenmin gelijk is aan de laagste waarde. 

Klik OK. 

Nu behoren in beide referentiepunten de RGB waarden gelijk te zijn. Alleen zullen de waarden in referentie-
punt #3 nog verschillen vertonen en dat komt omdat neutraal grijs nog niet is gecorrigeerd. Er zijn handlei-
dingen die aangeven, dat de neutrale tonen gecorrigeerd kunnen worden met de middelste schuifregelaar 
voor RGB in het venster Niveaus. Het risico van onbalans blijft dan evenwel bestaan. De volgende methode 
verdient de voorkeur omdat dan de correcties per kleurkanaal kunnen worden beoordeeld. 

Open Curven (Afbeelding>Aanpassingen>Curven). Alt+klik in de grafiek om de verdeling te verfijnen naar 10 
x 10. Open dan bijvoorbeeld Blauw in het pop-up venster, klik op het middelpunt en beweeg dit met de pijl-
toetsen op en neer tot het getal voor Blauw in referentiepunt #3 gelijk is aan de middelste waarde. Indien de 
waarde per toetsklik te grote sprongen maakt probeer dan met de pijltoetsen links en rechts te bewegen. 
Een ander hulpmiddel voor nauwkeurig werken is het plaatsen van een ankerpunt op de diagonale lijn boven 
of onder het midden. Een kwestie van uit proberen. 

Ga eventueel voor de andere kleur ook zo te werk totdat de drie RGB waarden in referentiepunt #3 gelijk 
zijn. 

 
Voor de correctie 

 
Na de correctie 
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Contrast en verzadiging 

Open Curven (Afbeelding>Aanpassingen>Curven) en Alt+klik in de grafiek om de verdeling terug te brengen 
naar 4 x 4. 

Ctrl+klik op een gebied in de foto dat wat lichter zou moeten worden en Ctrl+klik op een gebied in de foto dat 
wat donkerder zou moeten worden. Beweeg het eerste ankerpunt naar boven en naar links en het tweede 
ankerpunt naar beneden en naar rechts. Controleer steeds met aan en uitschakelen van Voorbeeld of de 
aanpassingen aan de verwachtingen voldoen. Wees uiterst voorzichtig. 

Voorzichtigheid is eveneens geboden bij het aanpassen van de Kleurverzadiging. Het is waar dat sommige 
snellere films en veel scanners de kleurverzadiging reduceren. Overdrijf echter niet ook al lijkt in eerste in-
stantie een oververzadigde foto aantrekkelijk, op den duur zal het toch niet bevredigen. 

Open Kleurtoon/Verzadiging (Afbeelding>Aanpassingen>Kleurtoon/Verzadiging) en beweeg de schuifrege-
laar voor Verzadiging ongeveer 10 tot 20 punten naar rechts. Controleer het resultaat met Voorbeeld (aan en 
uit) 

Aparte kleuren kunnen worden gecorrigeerd door een kanaal te kiezen en de desbetreffende kleur aan te 
klikken met het pipet. Het bewegen van de schuifregelaar is alleen van invloed op de geselecteerde kleur. 
Wederom: wees voorzichtig en blijf controleren met Voorbeeld. 

 
Voor de correctie 

 
Na de correctie 
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Verscherpen 

Een foto scherper maken is een onnatuurlijk proces. Het enige wat er gebeurt is het verhogen van het con-
trast tussen kleurovergangen van grote omvang. Daardoor lijkt de foto scherper. Nadeel is dat er kans is op 
het ontstaan van artefacten (misvormingen die meer schade aan het beeld toebrengen dan wat de verscher-
ping als verbetering oplevert). De hierna beschreven methode wordt het ontstaan van artefacten vermeden. 

Verander de modus 16-bits/kanaal (Afbeelding>Modus>16-bits/kanaal) en vervolgens naar Lab-kleur (Af-
beelding>Modus>Lab-kleur) 

Maak een duplicaat van het origineel (Afbeelding>Dupliceren) Photoshop geeft het duplicaat de naam van 
het origineel met de toevoeging ·kopie·. Verander het duplicaat naar 8-bit/kanaal en RGB-kleur. 

Open het Kanalen palet (Venster>Kanalen) en selecteer het kanaal Rood. Deze kleur heeft in de meeste ge-
vallen het hoogste contrast. 

Isoleer de randen met Filter>Stileer>Contrastlijn en maak het beeld negatief (Afbeel-
ding>Aanpassingen>Negatief of Ctrl+I). 

Teken de randen over met Filter>Ruis>Mediaan met een straalwaarde van 2. 

Verdik de randen (Filter>Overige>Maximaal) met de waarde 4 voor de straal. 

Vervaag de randen met Filter>Vervagen>Gaussiaans vervagen met een straalwaarde van 4. 

Verhoog het contrast tot een niveau waarbij artefacten nog net niet zichtbaar worden (Afbeel-
ding>Aanpassingen>Helderheid/Contrast). Wees hiermee erg voorzichtig; beter te weinig dan te veel verho-
gen!. 

Selecteer de omtrek door in het kanaal Rood te klikken met Ctrl+klik. 

Sla de selectie op (Selecteren>Selectie opslaan) en noem de selectie ·Randen masker· 

Maak nu het 16-bits origineel weer actief door er op te klikken. Klik op het kanaal Lichtsterkte in het Kanalen 
palet. 

Laad het geselecteerde Randen masker (Selecteren>Selectie laden>Randen masker) 

Onderdruk nu de lopende selectielijnen met Ctrl+H 

Kies Filter>Verscherpen>Onscherp masker; en stel de volgende waarden in: Hoeveel 150%, Straal: 1,5 
pixels en Drempel: 1 niveau. Klik OK. 

Hef de onderdrukking van de selectielijnen op met Ctrl+H en verwijder de selectie (Selecte-
ren>Deselecteren). Dit is erg belangrijk als er na deze bewerking nog andere acties volgen; die zouden dan 
alleen betrekking hebben op de selectie en dat is niet de bedoeling. 

 
Voor de correctie 

 
Na de correctie 
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Opslaan 

We hebben de foto nu in zijn geheel gecorrigeerd en hem qua kleur aanvaardbaar gemaakt. Dat wil overi-
gens niet zeggen dat de foto nu helemaal klaar is. Er kunnen nog allerlei detail aanpassingen gemaakt wor-
den die tot verrassende verbetering kunnen leiden. In de volgende hoofdstukken worden een aantal technie-
ken beschreven. Maar eerst slaan we het resultaat op van onze inspanningen tot nu toe. 

We wijzigen de modus in 8-bit/kanaal en in RGB-kleur en slaan het bestand op in Photoshop-formaat (PSD).  

Afbeelding>Modus> 8-bit/kanaal 

Afbeelding>Modus>RGB-kleur 

Bestand>Opslaan als>Vul de bestandsnaam in>Selecteer bij Formaat>Photoshop(*.PSD; *.PDD) 

Klik OK. 

 
Dit was het begin 

 
Dit is het resultaat 

 


